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1 Introduction  

This installation guide provides information for installing Publisher.  

System Requirements 
If you intend to use MediaSync, use the recommended configurations. 

SUPPORTED OPERATING SYSTEMS  

• Windows 10 Home and Pro (32- or 64-bit) 
• Windows 11 Home and Pro (64-bit) 

SOFTWARE 

• Microsoft XML Parser (MSXML) 3.0 or later (automatically installed with Publisher)  
• Windows Media Player 12 or higher (required for MediaSync) 

Creating a My RealLegal Account 
You must have a My RealLegal account to register and activate Publisher. After you install Publisher, you must activate Publisher 
using a My RealLegal user ID and password. 

Before creating a new account, you must verify whether an account for you already exists. Creating multiple My RealLegal 
accounts can lead to confusion. To verify whether you have a My RealLegal account, go to my.reallegal.com and attempt to log on. 
If you can log on, you have an account. 

If you have a My RealLegal account but do not remember your user ID, send an email to 
reallegalsubscriptions@thomsonreuters.com to request it. 

It is recommended that you use Microsoft Internet Explorer 6.0 or later to access the My RealLegal Web site. 

To create a My RealLegal account, complete the following: 

1. Go to my.reallegal.com.  
2. Click Create a RealLegal account.  
3. Type your information in the appropriate text boxes and make a note of your user ID and password. You cannot use the 

ampersand (&) or at (@) character in a user ID or password.  
4. Click Save. RealLegal will send you an email containing a link to access your account.  
5. Click the link in your email to verify your email.  
6. Click Continue.  

https://my.reallegal.com/
https://my.reallegal.com/
https://my.reallegal.com/
mailto:reallegalsubscriptions@thomsonreuters.com
https://my.reallegal.com/
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2 Installing Publisher 

It is recommended that you install Publisher on the same computer on which you installed E-Transcript Manager. If you install 
Publisher on a different computer, you must be able to access your transcript files over a network.  

To install Publisher, complete the following: 

1. Click the link for Publisher in the email sent to you from Thomson Reuters.  
2. Click Install to display the Install Shield Wizard for Publisher.  
3. Click Next. The License Agreement displays. You must scroll to the bottom of the license agreement as you read, click I 

agree to the terms in the license agreement, then click Next.  
4. Type your User Name and Organization in the appropriate boxes and click Next.  
5. Click Next.  

If you want to select a folder to install Publisher to, click Change, browse to a folder location and click OK.   
6. Click Install. 
7. Click Finish after the installation completes.   

To access Publisher, double-click the Publisher icon ( ) on the desktop.  
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3 Performing a Silent Installation 

It is recommended that an experienced information technology specialist execute a silent installation. If Publisher is currently 
installed, the program is uninstalled automatically when you install Publisher 6.6. You must manually uninstall all previous 
versions of Publisher. The silent installation uses Publisher installer. Below is an example silent installation: 
 
PublisherLF-6.6.exe /S /V"/qn LICENSE_CODE=CZZQ3-3JFHG-XXXXX" 
 
Where PubLF6.6.exe is the Publisher installer for a specific version of Publisher (your version may vary); /S is the parameter 
instructing the installation to run silently; and /V"/qn LICENSE_CODE=CZZQ3-3JFHG-XXXXX" is the parameter instructing the 
installer to use the provided license code CZZQ3-3JFHG-XXXX.  
 
The following parameters are also available: 
INSTALLDIR 
USERNAME 
COMPANYNAME 
 
As explained below, you must type backslashes and quotation marks for the parameters include spaces.  
 
For example,  
  
PublisherLF-6.6.exe /S /V"/qn LICENSE_CODE=CZZQ3-3JFHG-XXXXX INSTALLDIR=C: \TESTUSERNAME=QA-TEST COMPANY 
NAME=\"THOMSON REUTERS\""  
 
Where PubLF6.6.exe is the West Publisher installer for a specific version of West Publisher (your version may 
vary); /S is the parameter instructing the installation to run silently; /V"/qn LICENSE_CODE=CZZQ3- 
3JFHG-XXXXX" is the parameter instructing the installer to use the provided license code CZZQ3-3JFHG-XXXXX; 
C:\TEST is the installation directory; QA-TEST is the username; and THOMSON REUTERS is the company name. 
 
Note: The previous example shows backlashes and quotations marks around THOMSON REUTERS because the name includes 
spaces. If you use spaces in the values for the COMPANYNAME, USERNAME, or INSTALLDIR parameters, you must type 
backslashes and quotation marks around those values.  
 
Performing a Silent Uninstallation  
 
To run the silent uninstallation for Publisher 6.6, type the following command as a command prompt: 

Msiexec.exe /x{1B9B58EB-5CBB-497E-BBBE-82FEFC80A3CA} /qb 
 
If you want to perform a silent uninstallation for a different version of Publisher, contact West Publisher Customer Technical 
Support.  
 
To uninstall Bundle Viewer as well, type the following command as a command prompt: 
 
Msiexec.exe /x{99ACC64D-07C5-4C5D-A41F-166D07C7B508} /qb 
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4 Activating Publisher 

After you install Publisher, you must activate the Publisher license before using the program. You need an invitation code for each 
copy of Publisher you install. 
 
After activation, Publisher authenticates the license every 30 days via the Internet. If Publisher is installed on a computer that is 
not connected to the Internet, the license reverts to demonstration mode after 30 days. To authenticate the license, Publisher 
must have access to the Internet for the last five days of each month. 
To activate Publisher, complete the following: 

1. Double-click the Publisher icon ( ) on the desktop to access Publisher.  
2. The message This copy of West Publisher is not registered displays. Click OK.  

 
 

3. Click Activate.  

 
 
 
 
 
 
 
 

West Publisher

West Publisher

Activate Publisher

Publisher is exclusively available as part of RealLeqal Unlimited subscription
programs. Subscription plans include a variety of software products for court reporters as
Wellas unlimted upgrades and support for these programs.

For more information on RealLegal Unlimited subscription programs, contact your account

Using inDemoMode

To use Publisher in demo mode, close this window and work with the demonstration
Bundle.

WestPublisher X

Reallegal Login

Login to your Reallegal account to initiate service.
This account is required to use ReallLegal Publisher.

RealLegalSign-in

User ID:

Password:

Login

Create a RealLeqal account
Forqotten your password?
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4. Type your My RealLegal User ID and Password in the boxes and click Login.  

 
 

5. Type the invitation code in the I have received an Invitation Code from RealLegal and my Invitation Code 
is box, and click Next.  

 
 

6. A subscription name is entered for you in the box. Type a different subscription name, if desired. Click Finish. A message 
indicates your invitation has been accepted and the software is registered displays.  

7. Click Done.  
8. Click OK to finish.  

WestPublisher X

RegisterRealLegalPublisher

 I have received an Invitation Code from
RealLegal and my Invitation Code is:

I am re-installing RealLegal Publisher and want to attach an existing Subscription.
Warning! Only select this option if you are re-installing Reallegal Publisher.

<Back < 1xaN Cancel Help

Version 4.1.0.123 sf

WestPublisher X

SubscriptionName

Nameyour Subscription
This name wil be used to identify your account with us. We may
reference it in the future when contacting you. Please use a
descriptive narme to avoid confusion with multiple subscriptions. For
example, "ABC Reporting and Video - Kalamazoo Offce'

Thomson - Eagan Office

< Back Finish Cancel Help

Version 4.1.0.123 sf
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5 Activating Publisher from a Previous 
Version 

If you have Publisher 4.0 installed on your computer, you can upgrade by using the same invitation code for activation. Publisher 
4.0 remains installed on your computer, though you can only be logged into one version at a time with the same code. Care has 
been taken to prevent loss of data, but it is still recommended that you make a backup of your data. The default location for your 
files varies depending on your operating system. For example, if you are using Windows XP, the location is C:\Documents and 
Settings\All Users\Documents\RealLegal\ETXMgr\Files. 

To upgrade Publisher, complete these steps: 

1. Double-click the Publisher icon ( ) on the desktop to access Publisher.  
2. The message This copy of West Publisher is not registered displays. Click OK. The activate Publisher dialog displays.  

 

 
 

3. Click Activate.  
4. Type your My RealLegal User ID and Password and click Login.  

 
 

 
5. Select I am re-installing RealLegal Publisher and want to attach an existing Subscription and click Next.  

West Publisher

West Publisher

Activate Publisher

Publisher is exclusively available as part of RealLeqal Unlimited subscription
programs. Subscription plans include a variety of software products for court reporters as
Wellas unlimted upgrades and support for these programs.

For more information on RealLegal Unlimited subscription programs, contact your account

Using inDemoMode

To use Publisher in demo mode, close this window and work with the demonstration
Bundle.

WestPublisher X

RegisterRealLegalPublisher

 I have received an Invitation Code from
RealLegal and my Invitation Code is:

I am re-installing RealLegal Publisher and want to attach an existing Subscription.
Warning! Only select this option if you are re-installing Reallegal Publisher.

<Back < 1xaN Cancel Help
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6. A subscription name is entered for you in the box. Choose a different subscription name from the Subscription list, if 
desired, and click Finish. A message indicates that your invitation has been accepted and the software is registered 
displays. 

7. Click Done. The message Registration completed successfully displays.  
8. Click OK to finish.  

WestPublisher X

SubscriptionName

Nameyour Subscription
This name wil be used to identify your account with us. We may
reference it in the future when contacting you. Please use a
descriptive narme to avoid confusion with multiple subscriptions. For
example, "ABC Reporting and Video - Kalamazoo Offce'

Thomson - Eagan Office

< Back Finish Cancel Help

Version 4.1.0.123 sf
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6 Upgrading Publisher Bundles 

You can upgrade all Publisher 2.0 and later bundles for access to all transcripts, exhibits, and published bundles. You cannot 
upgrade Publisher 1 bundles.  

To upgrade a Publisher 2.0 or later bundle, complete the following: 

1. Double-click the Publisher icon ( ) on the desktop to access Publisher.  
2. Click the File menu, and select Open Bundle.  
3. Locate a bundle by completing one of the following: 

• Click Browse, and select Publisher 3 or 4 Bundle (bundle.xml) from the Files of type list. Select your 
file, and click Open.  

• Type a bundle title, client name, matter number, or reference in the Find box, and select the 
appropriate option form the In list. Click Find Now.  

4. Select the bundle you want to open in the list, and click OK.  
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7 MediaSync FAQs 

To use MediaSync, you must subscribe to Unlimited Multimedia Workflow. Below are some frequently asked questions about 
MediaSync.  

What is West MediaSync? 
West MediaSync is a tool that synchronizes two forms of media: a transcript of a deposition and a video of a deposition. When the 
media are synchronized, the video and the transcript can be viewed simultaneously on a computer with the transcript scrolling in 
synchronization with the voice of the speaker. 
 
Why do I need to purchase MediaSync hours? 
For each hour of testimony that you synchronize, you consume one hour of MediaSync time. You must have at least one MediaSync 
hour “in the bank.” For example, you need at least two MediaSync hours to synchronize a one-hour video or at least three 
MediaSync hours to synchronize a two-hour video, and so forth. 
 
Where do I purchase MediaSync hours? 
To purchase MediaSync hours, go to my.reallegal.com. After you purchase MediaSync hours, you must register MediaSync to 
indicate you have purchased MediaSync and have MediaSync hours available. 
 
How do I register MediaSync hours? 

To register MediaSync hours, complete the following: 

1. Go to my.reallegal.com.  
2. Type your User ID and Password in the appropriate boxes.  
3. Click Product Registrations in the left pane to display the Inventory page.  
4. Click Publisher MediaSync Hours 1.x to display the Distribute Registrations Codes for Publisher MediaSync Hours 1.x 

page.  
5. Select Register Now, and click Next.  

 

6. Double-click the Publisher icon ( ) on the desktop to access Publisher.  

  

R My RealLegal
Help I Profile I Logout

5/7/2009 RegisterNow

My Reallegal Product : Publisher MediaSync Hours 1.x Registration Help
Invitations Issue To : Thornson  Open the application and from
Product Registrations the Help menu select Register.

Purchase Products Site Code: Copy the Site Code and paste it
into the field, select the

Signatures Register:1  of the available 20 number of licenses that you
want to register and hit Finish.

DepoSchedule On the next screen, copy the
E-Transcript Internet registration key and paste it

into the field in the application.
Exemplaris

Reporter Edition

StenoBank
< Back Finish Cancel

Terms and Conditions I Privacy Policy I Site Feedback
@2007 RealLeqal LLC., All rights reserved.

Version 4.0.0.135 sf
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MediaSync FAQs  10 
 

7. Click the Help menu, and select Sync Hours.  

 
 

8. Copy the code in the Site code box.  
9. Go back to the My RealLegal Register Now page and paste the Site code into the Site code box. Click Finish. The Register 

Now page displays a page with a Registration Key.  
 

 
 

10. Copy the Registration Key.  
11. Go back to Publisher and paste the Registration Key in the Registration Key box. Click Register.  

 

 
 

12. Click OK to confirm, and click Close.  
13. Click Done on the My RealLegal Register Now page.  

SyncHours

Sync balance:0:00:00 Register

Site code.7F1D 52A2575B5E9A.04 Close
Registrationkey: About...

To obtain a personalized registration key for additional
sync hours,please contact RealLegal. Click About for
contactinformation.

RL My RealLegal
Help I Profile I Logout

5/7/2009 Register Now

My Reallegal Product : Publisher MediaSync Hours 1.x

Invitations Issue To : Thomson
Product Registrations

Purchase Products Quantity :1

Signatures Site Code : 7F1D 52A2 575B 5E9A 04

DepoSchedule Registration Key :6701 3579 42EC 1A32 796F 5C9F A5

E-Transcript Internet
Exemplaris
Reporter Edition
StenoBank

Terms and Conditions 1Privacy Policy I Site Feedback
@2007 RealLeqal LLC., All rights reserved.

Version 4.0.0.135 sf

SyncHours

Sync balance:0:00:00 Register

Site code:7F1D 52A2575B 5E9A.04 Close
Registrationkey:3579 42EC 1A32 796F 5C9F A5 About...

To obtain a personalized registration key for additional
sync hours,please contact RealLegal. Click About for
contact information.
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